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1. INTRODUCTION 
 

WARNING: 
 
The USB-DAM acquisition module of the ERGO-PS system provides complete electric insulation of 
the patient conform to the IEC 60601 standard. Anyway, some personal computers and printers have a 
strong current discharge to ground. If the connection to ground of the computer opens accidentally and 
the attendant is in simultaneous contact with the patient and with the metallic parts of the computer, it 
exists the possibility that the patient receive a discharge through the attendant. This situation is highly 
improbable. Even though, if the stretcher and computer distribution make this possible, it is an 
obligation to have a security insulation transformer between the power line and the Computer/Printer 
equipment. 

 
The GALIX ERGO-PS is a 12 lead real time, PC Driven Electrocardiograph and Stress Test system, 
capable to monitoring, analyzing storing and printing ECG patient records.  The system meets most of 
the present and future needs of the cardiology clinician. 
 
The GALIX ERGO-PS will present high-resolution images of a patient’s ECG study and stores the 
study in the memory for future reference or analysis.  The attendant can change leads displayed, gain, 
time, etc.  All essential commands are available through menus, buttons or keystrokes. 
 
The GALIX ERGO-PS measures cardiac rate and other basic parameters, indicates bradycardia and 
tachycardia events by visual and audible means.  All relevant information, date, time, etc, is presented 
in the screen 
 
The  GALIX ERGO-PS system is based on a hand held Data Acquisition Module (USB-DAC) with a 
computer USB interface that acquires high resolution ECG. Patient cables are connected directly to this 
module.  The USB connector can be connected to any USB port in a Lap Top or Desk PC. The module 
is powered through the USB port eliminating the need for an additional supply. 
 
The GALIX ERGO-PS software will show computerized ECG and Stress Test studies. The GALIX 
ERGO-PS will operate under Windows 98 or greater. These are some of the characteristics of the 
program: 
 
• Simultaneous monitoring and printing of standard 12 lead ECG or pre selected lead combinations  
 
• Different selectable presentation formats 
 
• Selectable Amplitude Scales (5, 10 or 20 mm/mV) 
 
• Selectable Scan Rates ( 25, 50 or 100mm/s) 
 
• Heart Rate measurements in the 30 -240 bpm range 
 
• Manual and automatic selection of J Point  and ST  
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• Standard and programmable stress test protocols 
 
• Able to control peripheral equipment (treadmill, bicycle, etc) 
 
• Time and amplitude measurements by screen cursors 
 
 
1.1. ELECTROCARDIOGRAPHY 
 
The Galix ECG –PS offers different Print forms including different Number of leads per page (1, 2, 3, 
6, or 12) and gain (xl, x1.5 or x2). The printouts includes name of patient, date, hour, etc, for ease 
identification.  
 
All ECG registries may be stored in a PC hard disk for further analysis or revision.  These studies 
stored in a database that includes some handling commands (Add, Delete, Search, etc). 
 
Due to the high detailed resolution, the system will allow full morphological analysis. The clinician is 
able to obtain time periods, amplitudes with cursors and the automatic measurement tools of the 
software. 
 
 
1.2. STRESS TEST 
 
 
The GALIX ERGO-PS allows patient a Stress Test to be conducted using anywhere from 3 to 12 leads 
with standard preprogrammed protocols (Bruce, Bruce Modified, Naughton, Astrand, etc) or protocols 
defined by the user. 
 
The GALIX ERGO-PS system can work with treadmills and ergometric bicycles in manual mode. In 
addition to this the GALIX ERGO-PS can work in automatic mode with some remote-controlled 
treadmills available in the market. In this case, the treadmills are commanded through a serial RS-232 
link. GALIX Biomedical Instrumentation provides neither treadmills nor ergometric bicycle. 
 

WARNING: 
In case of using a supported remote-controlled treadmill, the control panel of this device must have a 
display to present the actual speed and the slope. If these values differ from those programmed, the user 
should consider the treadmill panel indication as valid. 
GALIX Biomedical Instrumentation assumes no responsibility for malfunctioning in case the 
treadmill lack this facility. Likewise, it assumes no responsibility if the customer uses a remote-
controlled treadmill other than the supported one. 

 
The GALIX ERGO-PS displays the different stages (speed, elevation or load), elapsed time, and 
messages to guide the attendant during the study.   
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The final Exam printout will include the following information: 
• Demographic Patient information 
• Table presenting for each stage: duration, load, heart rate, systolic pressure, diastolic pressure, 

mean pressure, time, index and commentary. 
• ECG strips. 
 
The Stress Test study may be stored in the PC Hard disk, in the database.  Individually these are 
identified for future retrieval and further analysis.  The number of studies stored is limited only by the 
capacity of the PC’s hard disk. 
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2. ECG PROFESSIONAL STATION 
 
The main program of very high resolution electrocardiographic signal acquisition 
is described below. 
 
2.1. STARTING AND ENDING AN EXAM 

 
Initiating a study: 
 
To begin the electrocardiogram the user must: 
 
1. Double click the “ERGO-PS” icon in the desktop and Figure 1 will appear: 
 
 
 

 

c ea

g

d f

h

b

 
 
 

Figure 01 
 
2. In the Patient text box (Figure 01-a) type the name of the patient. While writing, the name will be 

automatically completed with the existing patients from the database. To add a patient click on “New 
Patient” button (Figure 01-g) and complete the data. (See Section 2.1.4). 

3. In the Attendant text box (Figure 01-b) type the name of the physician. The attendant’s name will be 
automatically completed with the names in the attendant s database. If the attendant is a new one you must 
click on “New attendant” button (Figure 01-h) and complete the data (See Section 2.1.4). 

4. Once selected the patient and attendant you can access to the application by clicking on OK to open the 
monitoring screen that is shown in Figure 06. The OK button will be activated only when the patient and 
the attendant had been selected. 

5. Click on  button from de “monitoring control” (Figure 07-e) to start the ECG acquisition. 
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Ending a study: 
 
To stop the ECG acquisition: 
1.  Open on SCAN menu from the Options Menu (Figure 07-h) and then click STOP option. Answer YES to 

the question. This operation can also be called by clicking on the  button (Figure 07-e) from the 
monitoring control toolbar. 

2.  Click on the “diskette” icon from the toolbar (Figure 07-g) to save the study. 
3.  If the study is successfully saved the message “Data Saved” will appears. 
 
  NOTE: This process lasts a few seconds, depending of the extension of the stored study. 
 
 
2.1.2. ADVANCED PATIENT AND ATTENDANT SEARCH 
 
In this dialog the user can search a patient or an attendant. The search can be done by ID, name or both. 
 
To make a search: 
 
a) Click the advanced search button (see Figure 01-e and f).  The Advanced Search dialog will appear (see 

Figure 02). 
 
b) Type the ID and patient name in the corresponding fields (Figure 02-a and b). For a broader search leave 

some of the fields empty. 
 
c) Click the Search button (Figure 02-c). 
 
d) The results will be displayed in the Results Grid. 
 
e) If the Patient or the Attendant is in the list of the Result Grid, select it by clicking on that row. 
 
f) To use the selected Patient or Attendant in the study, click the Select Patient button. (Figure 02-d). 
 
g) To cancel the search simply press the Cancel button (Figure 02-e). 
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Figura 02  
 
2.1.3. PATIENT AND ATTENDANT DETAILED VIEW 
 
Once selected the Patient or the attendant, the user can click the View Details button (see Figure 01-c and d) . 
This button will open a dialog with the Patient or Attendant information stored in the database (see Figure 03). 
 

  
Figure 03 
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2.1.4. ADD A PATIENT OR AN ATTENDANT TO THE DATABASE 
 
If the Patient or the Attendant is not in the database, the user can add them by clicking on the New Patient or 
New Attendant Button (Figure 01-g and h). 
 
To add a Patient: 
a) Click on the New Patient button. The New Patient dialog will be displayed (see Figure 04). If the button is 

disabled, the selection must be deleted in the Patient field (Figure 01-a). 
b) In this dialog the fields with red title must be completed to add the patient to the database. The ones titled in 

black are optional. 
c) Click on the OK button. The dialog will be closed, the Patient will be added to the database, and selected in 

the Actors dialog. 
d) To cancel the operation click on the Cancel button. 
 
 

 
 

Figure 04  
 
To add an Attendant: 
e) Click on the New Attendant button. The New Attendant dialog will be displayed (see Figure 04). If the 

button is disabled, the selection must be deleted in the Attendant field (Figure 01-b). 
f) In this dialog the fields with red labels must be completed to add the Attendant to de database. The ones titled 

in black are optional. 
g) Click on the OK button. The dialog will be closed, the Attendant will be added to the database, and selected 

in the New Study dialog. 
h) To cancel de operation click on the Cancel button. 
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Figure 05 
 
2.2. ERGO SCREEN ELEMENTS 
 
 
 

 

Monitoring 
screen

Review 
screen 

Split 
Screen 

 
 

Figure 06 
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MONITORING SCREEN (Left Side): 
  Exhibit real time ECG signals. 
 
Review SCREEN (Right Side): 
  Allows a complete study review on the study 
 
SPLIT SCREEN BAR 

Divides the screen into 2; monitoring and review screens.  The size of each screen can be changed by the 
attendant by clicking on the bar with the mouse and moving the line. 
 

 
FILTERS: 
 
 
The attendant can introduce the following filter at any time during the exam. 
 

• Line:   To minimize the interference generated by the power line (50 or 60 Hz, specified 
in the system configuration). 

 
• Muscular:  To minimize the interference generated to the ECG by myoelectric potentials 

noise.         
 

• Baseline: To minimize the interference generated by skin-electrode interface to the ECG 
Baseline.                       
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The following controls are available during the ERGO exam: 
 
a) Control Panel 
b) Position Control 
c) Channel bar in the Monitoring Screen 
d) Channel bar in the Review  Screen 
e) Monitoring Control 
f) Tool Icons 
g) Print Control 
h) Option menu 
i) Filters 
j) Herat Rate Meter 
k) Position Bar 
l) Gain Control in the Revision Screen 
 
 
 
 

 

d) Review screen 
channels h)  Options Menu j) Heart 

rate meter 

g) Control de 
Registro

a) Control 
Panel 

e) Scan 
Control

f) Tool Icons c)  Channel 
bar in the 

Monitoring
Screen 

l) Gain 
Control in 
the Review

Screen 

i) Filters 

k – Position Bar 
 

 
 

b) Position control

 
Figure 07  
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2.2.1 OPTIONS MENU: VIEW 
 
Within the Options Menu (Figure 07-h), a “View” icon is available, allowing to the attendant the following 

ptions: o
 

• Tool Bars:  Makes the toolbar visible 
 

• Status Bar: Makes the status bar visible 
 

• Scan Window Channel Bar: Makes the channel bars visible in the scan screen 
 

• Review Window Channel Bar: Makes the channel bars visible in the review screen 
 

• Scan Window Grid: Makes the grid lines in the scan screen visible 
 

• Review Window Grid: Makes the grid lines in the review screen visible 
 

• Tag List: Presents a list of all events captured during the exam 
 

• Black Background: Changes the background color. 
 

• Line Thickness: Permits a change of line thickness.  This option is useful for making slides. 
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2.2.2 PROCESS INDICATORS 
 

 

2 Attendant’s 
Name 

1) Patient’s 
name

3) Elapsed time 
during exam 

 
 
 
 

 
 
 

Figure 08 

 
 

 
 
 

 
 



 
2.3 CONTROL PANEL  
 

Print 

 

Amplitude and scan selectors of 
the monitoring screen (only 
actives channels) 
List of leads Configurations
Availables  
GALIX Biomedical Instrumentation             GALIX ERGO-PS – Operati

 
 
 
 
 
 

 
 

 

 

Figure 09 
 
PRINT (See Figure 07-g) 
This button prints the ECG signals shown in the review screen. 
 
PRINT LAST 10 SECONDS: 
Prints the last ten seconds of ECG acquired. 
 
CONFIGURATIONS
List of leads configurations available.  
 
SPEED
25- 50- 100: The scanning speed in mm/sec. 
 
AMPLITUDE 
1 – 1.5 – 2: Sets the gain of every ACTIVE channel.   
 
DISPLAYS 
(1) Indicates the scanning speed in the scan and review screens. 
(2) Present position in minutes and seconds of the review screen. The p
the position control. (Figure 10). 
 
 
2.4 POSITION CONTROL IN THE REVIEW SCRE
 

(a)                         Figure 10             

The position control of the Review Screen allows locating quickly any
 
The cursor  is use to display the study ECG of the Review Screen
cursor. The corresponding time of the cursor in minutes and second
(Figure 09-2). 
 

Speed indicator of the review
screen 
(1) Speed indicator of the
scan screen 
 

(2) Real time location of
the cursor in the review 
screen 
on Manual             V2.2                   6.15 

osition can be modified with the cursor of 

EN 

            (b) 

 moment of a study. 

. Simply drag with the mouse the position 
s is indicated in the CONTROL PANEL. 
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Additional possibilities to review the ECG on the review screen (See Figure 10): 
•  : Displays the initial portion of the study 
•  : Displays the end portion of the study  
•  : Rewinds the ECG shown 250 msec. 
•  : Forwards the ECG shown 250 msec 
•  : Opens the New Position window (See Figure 11) 
•  : Opens Tag List window  (Figure 07) 
 
The New position and Capture windows are explained below. 
 
 
 
2.4.1. NEW POSITION WINDOW 
 
This window provides a quick access to any moment in the study. Just introduce the values in minutes and 
seconds. The signals corresponding to the time selected will be displayed in the review screen.  
 
The New Position window is shown by clicking on the button   of Figure 07. 

Figure 11 
IMPORTANT: Fill the values of New Position according to the assigned digits.  
 
     MINUTES:  SECONDS  
        two digits         two digits       
 
The time entered is applied after clicking the OK button. The review screen will show the ECG corresponding to 
the selected time.  
 
 
 
2.5. CHANNEL CONTROL BARS 
                                                                                                                                                                                                         
The channel control bars are located to the left of the scan and review windows. (Figure 15). They can be hidden 
independently with the corresponding options in the View menu. 
 
 
(a) Channel signal identification. 
(b) Channel Gain (amplitude). 
(c) Selected Channel. By clicking on a channel a dialog box is displayed with its properties (see Figure 16). The 
background of the selected channel will be shown in orange.  
 
 
 
 
 
 
 

b

a 
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1 

 
(1) Identification of the selected lead 

 
(2) Displays to choose the color of the selected lead 

 
(3) Modifies the gain of the selected lead 

 
(4) Attributes of the selected lead 

 
 

2 

3 

4 
 
 

 
 Figure 16 

 
 
The CONTROL CHANNEL window options: 
 
(1)  CHANNEL:  
• Leads available for the selected configuration. 
• Select a lead to configure it.   
 
(2)  COLOR: 
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• It is use to change the color of the lead. 
• Shows the color pallet available. 
 
(3)  GAIN:  
• Move the cursor to the right or left to increase or decrease the amplitude of the selected lead. 
• The new gain is also shown in the bar. 
 
(4)  ATTRIBUTES  
 
VISIBLE: 
• Makes the derivation visible in the screen. The other leads will tile automatically. 
• IMPORTANT: even though the lead is NOT visible, the signal is acquired and processed.  
 
ACTIVE: 
• Active:  The lead gain is modified when the general gain of the CONTROL PANEL is changed. 
• Inactive:  The lead gain is not modified when the gain of the CONTROL PANEL is changed. 
 
CLIPPED: 
• Yes: the signal of the lead is restricted to the width of its channel. 
• No: the signal of the lead is not restricted to the width of its channel 
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2.6. MONITORING CONTROL 
 
This toolbar is located on the right of the screen (See Figure 07-e), has the following buttons:  
 
 
 
 
 
 
 
 

BEEP / NO BEEP. Enable a sound per each QRS detected. 
Begins the study . Acts only once. 

PAUSE / NOT PAUSE  of the monitoring screen. ( Enable [PRINT]). 
Stops the study. 

 Figure 17 
          
 
2.7. TOOLS ICONS 
 
The following tools are available in the tools toolbar: 
 
 

Selection  
Magnifying glass 
Caliper for time measures 
Caliper for amplitude measures 

 
 
 
 
 
 

 
Figure 18 

 
 

 Selection tool 
• Click on   . 
• Select with the mouse the object you want to control and click it with the right button. 
• Select with the mouse the tool you want to use and click it with the left button. 
 

  Zoom tool 
  This tool changes the speed of the view clicked. 
• Click on  . 
• Move the mouse cursor on the scan or review screen.  
• Click on with the left button of the mouse to increase the speed in the selected view. 
• Click on with the right button of the mouse to decrease the speed on the selected view. 
  

  CALIPER:  
To activate the caliper you must click with right button on the screen that you want to work . (See section  2.9 
CALIPER) 
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2.8. REGISTER CONTROL 
 
NOTE: It is recommended that the user get used with the basic commands of MS Windows in order to 
obtain maximum efficiency in the use of the following functions. 
 

Figure 19 

Open a new patient 
Save study 
Cut the selected object  
Copy the selected object 
Paste the object selected or cuted 
Print preview (1) 
Print (2) 

 
Print   
Prints the ECG shown in the review screen.  
 
Print Preview  
Prints preview of the ECG shown in the review screen (See Figure 20). 
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b d c a 

 
Figure 20 

 
 

(a)  Click on Print  to print the shown page. 
(b)  Click on Zoom In  to enlarge the image. The arrow of the mouse will change to a magnifying glass. Point 

and click the area to enlarge. 
(c) Press Close in order to close the Print Preview window without printing. 
 
Note: In a color printer, all the objects and signals will appear with their correspondent colors.  
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2.9. CALIPER 
 
The program allows to insert calipers to measure time periods (msec) and amplitudes (mvolts) .  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Changes from msec. 
to ppm (frec.) with 
the right button of 

the mouse

Drag moves the 
complete caliper 

Drag the caliper to 
resize 

Drag  the anchor 
to move the value 

measured 

Drag the caliper to 
resize 

Figure 21 

Procedure to activate the calipers: 
• Click on  . 
• Click on  with the left button of the mouse. 
 
Measurement: 
The arrow of the mouse is   . 
• Click on the first point of  the measurement and drag the mouse (maintaining the button pressed) to the 

second point of the measurement, then release the mouse button. 
IMPORTANT: Observe that pressing the right button of the mouse transforms the measurement indicated in 
milliseconds (msec) into beats per minutes (bpm) 
 
Insert a new caliper: 
The  tool will maintain active after inserting a caliper. To add another one follow the steps detailed above. 
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Erasing calipers: 
• Select the caliper you want to erase with the  tool. 
• Click on  button. 
• If there is only one caliper it will be erased. 
• If there were more than one caliper the following question will appear: Do you want to cut them all?  

- "YES" Will erase all calipers from the screen. 
- "NO" Will erase only the selected caliper. 

Note: Clicking the Paste button will recover the last caliper erased. (Figure 19). 
 
Changing caliper color: 
Select the caliper (square in the upper part of the caliper) 
• Select VIEW form the OPTIONS menu (Figure 07). 
• Select COLORS. The color dialog box will appear. (Figure 22). 
• Click the desired color. 
 
 

 
 

Figure 22 
 
 
 
2.10. CHANNEL LIST 
 
The properties of the channels of the review screen can be directly modified. The second option allows to 
quickly modify several channels without going one by one.  
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2.10.1 CHANNEL LIST IN THE MONITORING SCREEN       
 
Select Scan Window Channel List in the Channel List item form the Options menu. The Scan Window Lead List 
dialog will appear (see Figure 23 and Figure 24).  
 
 

 
 

 Figure 23 - Vectorials 
 

 
 

Figure 24 -  Not Vectorials  
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The Scan Window Lead List dialog allows the physician to modify all the properties of the channels that are 
being acquired. 

 
  #: Number of the channel (de 1 a 12) 
 Input Channel: Indicates which lead will be used. Making a double click on any cell of this column will 

display a list box containing the leads available.  
 Label: Description of the lead. This description can be modified at any time along the study, recording 

all the changes and the moment when it happened. To modify it, just do double click on the cell and 
insert the new description. 

 Gain: Modifies the gain of the lead signal. To modify the value double click on it. 
 Visible: Shows or hides the lead on the review screen. Double click on the cell inverts its value. 
 Active: All the active leads will change when changed from the Control Panel (See Figure 16). Double 

click on the cell change its value.  
 Clipped: Indicates if the lead will be drawn clipped or not. Double click on the cell change its value. 
 Color: Displays the colors of each lead. 

 
Once the changes are done the physician can: 
 

a. Apply the changes: Click the Apply button. 
b. Cancel changes: Click the Cancel button. 
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2.11 ADD OR MODIFY A PROTOCOL FOR AN ERGO STUDY 
 
To add or modify a protocol for a stress test study, the user must select from the Preferences Menu the Ergo 
Protocol Setup Option. The Ergo Protocol Setup dialog will appear (See Figure 25). 
 

 
 

Figure 25 –Ergo Protocols Setup dialog  
 
To modify a protocol, select it from the list on the left. Then modify the values desired in the grid that 
describes each of the stages and click on “Save Changes” button. 
 
To add a new protocol click on “Create Protocol” button. The New Protocol dialog will appear, specify 
the name, description and type (Treadmill or Bicycle) of protocol to create. Define each stage. The 
definition of each stage must not have empty spaces, otherwise the stage will not be saved. To save the 
protocol you must click on “Save Changes” button. 
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2.12 SISTEM CONFIGURATION 
 
To configure the system choose Configuration from the Preferences menu and the configuration system 
dialog will appear. In this dialog the system options are separated in tabs.  
 
Filters 
 

 
Figure 26 – Filters configuration dialog   

 
Select the frequency of the line filter according to the country were the system is used. 
 
Print Format  
 

 
Figure 27 – Print Format configuration dialog  

 
The format established in Normal Print Format and Flash Print Format, will be used when printing 
form the review screen and the last 10 seconds of signal respectively. 
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Institution 
 

 
Figure 28 –Institution configuration dialog  

 
Configuration of the institution where the studies are done. The name of the institution is printed in the 
title of the ECG prints.  
 
Alarms 

 

 
Figure 29 – Alarms configuration dialog  

 
A tachycardia alarm will trigger when the heart beat rate is greater than the value of the limit 
established. In the same way a bradycardia alarm will trigger when the heart beat rate is lower than the 
value of the limit established. In order to be able to listen to the alarms the PC must have a sound card 
and speakers, otherwise you will only see the visual alarm.    
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Preferred units 
 

 
Figure 30 – Units configuration dialog  

 
Preferred units, Km or Miles. For example the treadmill speed in Km/h o Mi/h. 
 
Actors 
 

 
Figure 31 – Actors configuration dialog  

 
If patient and attendant codes are auto generated, is it possible to configure the prefix for each one of 
them.   
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Recovery Stage

 
Figure 32 – Recovery Stage configuration dialog  

 
Recovery stage configuration. This stage is common to all the Stress Test protocols, but of course, it is 
different for treadmill and bicycle protocols. When this stage is concluded, the blood pressure is 
measured and the stage is restarted. 
  
Pre-effort  Stage 
 

 
Figure 33 – Pre-Effort Stage configuration dialog  

 
Pre-effort stage configuration. This stage is common to all protocols, differentiated by the type. When 
the stage is concluded, the first stage of the Stress Test protocol is started.  
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Stress Test 
 

 
Figure 34 – Stress Test configuration Dialog 

 
General configuration of the Stress Test. Automatic go to next stage, when the stage is concluded the 
system will automatically pass to the next stage. Confirm go to next stage, 30 seconds before the stage 
is concluded the attendant is warned of the end of the stage. Automatic print on stage change, prints 
ECG when the stages changes. Select Treadmill, selects the treadmill to control. If a treadmill is 
selected the user must close and restart the program.  
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3. ASIGNMENT OF THE CONTROL KEYS  
 
When opened the scan window some of the keyboard keys have the following special functions: 
 
 >   (RIGHT arrow): Increases the speed of the scan and review screens. 

 <   (LEFT arrow): Reduces the speed of both screens. 

 ↑   (UP arrow):  Increases the amplitude of all channels. 

↓   (DOWN arrow):       Reduces the amplitude of all channels. 

 

HOME :  Moves the signals on the review screen to the beginning of the study. 

END :   Moves the signals on the review screen to the end of the study.  

PAGE UP :  Moves the signals on the review screen 250 msec backwards. 

PAGE DOWN :  Moves the signals, in the review screen 250 msec forwards. 

SPACE BAR :  Freezes / Defreeze The signals on the scan screen. 

Clicking on the image freezes at the end of the scanning. Making a double click freezes 

the image instantly. 

Control + B :  Enable / Disable the acoustic “BEEP” of the QRS. 

 

 
 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
IMPORTANT: The Data Acquisition Module should be cleaned regularly, using a cloth with alcohol. 

4. TECHNICAL SPECIFICATIONS 
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GALIX ECG-PS Data Acquisition Module (DAM-PS) 
 
Input Amplifier 
Frequency response:  0.05Hz±11% a 500Hz±5%  @ -3dB 
CMRR :   100dB min, @ DC to 60Hz 
Background added noise: 1.1 µVrms max, @ 0.05Hz to 500Hz 
Input Signal Span:  16.4mVpp±3% @ 10Hz 
Electrode offset Tolerance: 300mV min. 
Lead Input Impedance: > 100 Mohm @ DC to 500Hz 
Lead Bias Current:  1nA max 
Reference Compensation: Selectable for Limb or XYZ electrodes 
Patient Connection:  10 leads (Limb+Chest) / 7 leads (Limb+XYZ), shielded cables with 

current limitation 
 

Data Acquisition 
Sampling Rate:  3000 samples per second per lead (1000 Sample/sec/lead, normalized) 
Sampling Resolution:  0.25mV±3% (1 µV, normalized) @ 10Hz 
Data Resolution:  16 Bits (14 Bits, normalized) 
Analog Anti-Alias Filter: 500 Hz±5%, 3º order, Butterworth low pass 
Modes:    12 Leads (Limb+Chest) / 9 Leads (Limb+XYZ) 

 
Electrical 
PC interface:   Full Speed USB 1.1, 12Mbit/s 
Power consumption:  100mA max (supplied by Computer USB Port) 
Patient Isolation:  2500V, 50pF max 
Patient Leakage Current: < 5uA (Patient Electrically Isolated) 
Defibrillator Protection: 5 KV, 10 ms / 400 Joules 

 
Physical 
Size:    5.5” (140mm) x 2.5” (63mm) x 1.2” (31mm) 
Weight:   0.5 lbs (230g), USB Interface Cable Included 
Enclosure:   Water and Dust Proof, ergonomic design 
Interface Cable length:  10ft (3m) 
Color:    Off-White 
External Material:  ABS (UL 94 HB) 

 
Environmental 
Operating Temperature: 50 to 110ºF (10 to 45ºC) 
Storage Temperature:  -4 to 150ºF (-20 to 65ºC) 
Operating Humidity:  5 to 95% relative, non condensing 
Storage Humidity:  5 to 95% relative, non condensing 
Atmospheric Pressure:  700 to 1060 hPa 
GALIX ECG-PS Software (running on PC) 
 
Signal Processing 
(Overall digital tolerance less than 0.1%) 
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Low Pass Filter:   150 Hz, FIR type 
High Pass Filter:   0.05Hz / 0.15Hz / 0.5Hz, 3rd Order 
Muscle Filter:    35Hz @ -3dB / 72Hz @ -40dB, Chebycheff Inv. 
Baseline Drift Filter:   None / 0.5Hz 
Line Suppression Filter:  None / 50Hz / 60Hz, 60dB min 
Output Data Rate:   1000 Sps 
Output Data Resolution:  14 Bits 
 
Signal Analysis 
(calculated on the basis of the entire 10-sec recording) 
Rate [bpm]:  Heart Rate ± 2% or 3bpm 
ST-L [mV]:   deviation of the ST segment from the isoelectric level in lead “L” ±0.1mm 
STsl-L [mV/ms]:  slope of the ST segment in lead “L” ±15% 
 
 
Minimum PC requirements 
SCREEN: 

• Monitor:    SVGA Color, 15” (Recommended: 17”) 
• Resolution:   1268 x 1024 / 1024 x 768 pixels,  Non-interlaced, Color: 16 bits 

COMPUTER: 
• Processor:   PENTIUM III 700 MHz (or better) 
• Hard Drive:   30 Gbytes (o better) 
• RAM:   128 Mb 
• I/O:   Parallel, USB, Serial 
• Accessories:  Keyboard and Mouse 
• Operating System:  Windows98, Windows Me, Windows XP 

 
 
Standard Accessories 
• Five 2-lead fully shielded patient cable 
• Four clamp electrodes (limb leads) 
• Six suction electrodes (chest leads) 
• One Installation CD 
• One Hard-Lock protection key 
• One Operation Manual 
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S/N: 723501 

 
 
 
 

Front Label 
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5. WARRANTY 
 

GALIX BIOMEDICAL INSTRUMENTATION 
 

Limited Warranty 
 
GALIX Biomedical Instrumentation provides to the original purchaser the following limited warranty 
from date of invoice. 
                                   All serialized parts            18 months 
                                   Accessories, i.e. patient    90 days 
                                   cables, disposables 
 
GALIX Biomedical Instrumentation warrants each instrument to be free from defects in material and 
workmanship. Liability under this warranty covers servicing of the instrument when returned from the 
customer’s facility prepaid to the factory. GALIX Biomedical Instrumentation will repair any 
component(s) or part(s) that is finds to be defective during the period of this limited warranty. Should a 
defect become apparent, the original purchaser shall first notify GALIX Biomedical Instrumentation of 
the suspected defect. The instrument should be carefully packaged and shipped prepaid to: 
 

GALIX BIOMEDICAL INSTRUMENTATION 
Service Department 

2555 Collins Avenue,  Suite C-5  Miami Beach,  FL 33140,  U.S.A. 
Tel.: (305) 534-5905   Fax: (305) 534-8222 

 
Your instrument will be repaired in the shortest possible time and returned by the same shipping 
method as received by the factory. 
This limited warranty is void if the instrument has been damaged by accident, misuse, negligence, act 
of God, or if the instrument has been serviced or modified by any person not authorized by GALIX 
Biomedical Instrumentation. 
Equipment distributed by GALIX Biomedical Instrumentation such as, but not limited to personal 
computers and printers will carry the original equipment manufacturer’s warranty and will not be 
warranted by GALIX Biomedical Instrumentation. 
This limited warranty contains the entire obligation of GALIX Biomedical Instrumentation. and no 
other warranties expressed, implied or statutory are given. No representative or employee of GALIX 
Biomedical Instrumentation is authorized to assume any further liability, or grant any further 
warranties except as set herein. 
 

 
GALIX BIOMEDICAL INSTRUMENTATION 

2555 Collins Avenue, Suite C-5 
Miami Beach, FL 33140,  U.S.A. 

Tel.: (305) 534-5905   Fax: (305) 534-8222 
E-mail: info@galix-gbi.com 
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